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The Mobile Internet experience on your 

PDA 

 
 

Welcome to EzWAP 

 
EzWAP places Mobile Internet information and services in the palm of your hand. Devices such as Pocket 
PCs and Handheld PCs which run the EzWAP micro-browser, offer easy and secure access to relevant 
Internet/Intranet information over wireless networks thanks to the integrated support for WML 1.2.1, cHTML 
and XHTML basic standards. Simply install EzWAP on your device, connect to your Internet Service 
Provider (ISP), and then you can browse Mobile Internet sites as easily as you currently browse HTML sites 
using a standard web browser.  
 
This document describes how to quickly get started with EzWAP. 
 
 
 
 
 
 

Enjoy mobile surfing anywhere! 
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Configuring EzWAP 

Before using EzWAP for the first time you have to configure your Pocket PC or Handheld PC 
connection settings to enable communication with your provider. 

To configure EzWAP 

1. In the EzWAP Tools menu, select Options…. 

 

2. Select the General tab to edit the general settings. 

 

- Use the Connection selection box (1) to select the dial-up connection to be used.  

- Check the Connect automatically box (2) if you want EzWAP to automatically activate the 
selected connection when needed. 
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- To change the default WML document that will load automatically as home page, enter a valid 
URL in the Home page  box (3). 
Or, 
Tap the Use default button (4) to select the default EzWAP page as standard home page. 

- Check the Break line after images, anchors and edit fields box (5) if you want a line feed to 
be automatically inserted after input fields, anchors and images. 

- Check the Force images to fit screen width box (6) if you want images to be automatically 
adjusted to the size of your screen. 

3. Select the Connection tab to provide technical details about your WAP connection. Under 
Connection type, select one of the following options: 

Proxy  
Select this option if your mobile phone network operator does not operate a WAP gateway today 
(please consult the operator for details) and you want to use your regular Internet Service 
Provider to access WML-based sites.  

 

- Complete the Address box (1) with the IP Address of your service provider, for example: 
63.254.8.6.  

- Complete the Port box (2) with the port number of the proxy, for example: 80. 
If applicable, complete the User authentication box (3) with your personal account number 
and the Password box (4) with the corresponding secret code.  

Gateway  
Select this option if your mobile phone network operates a WAP gateway and you want to benefit 
from the additional servi ces provided by your operator. Please consult the operator for details.  

2 

4 

3 
1 



EZOS EzWAP 2.1  Readme 

 
 
 

Belgium 
Rue de l'Hôpital, 5 
B-1420 Braine-l'Alleud 
Phone: +32 2 387 20 00 
Fax: +32 2 387 20 10 

France 
Boulevard de Valmy, 1 
F-59650 Villeneuve d'Ascq 
Phone : + 33 3 20 19 00 60 
Fax : + 33 3 20 19 00 69  

E-mail: info@ezos.com 
Web site: http://www.ezos.com 

 

 

- Complete the Address box (1) with the IP Address for the WAP gateway. This is a sequence 
of digits comprised of four integers separated by decimal points, for example: 193.96.141.24. 
This information can be found in the notice included in your operator's welcome pack.  

- Complete the Port box (2) with the port number used by the WAP gateway, for example: 
9200. 

- Select the Connectionless gateway check box (3) if the gateway works in connectionless 
mode. 

- Select the WTLS secured connection check box (4) if the gateway uses the WTLS 
technology for enhanced security over the wireless network. 

None  
Select this option if you do not connect through a proxy or a gateway. 

4. Under Timeouts, specify the Connection timeout in milliseconds and the number and timeout of 
connection Retries. 

5. Select the Push tab to edit the push options.  
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- Select the Enable push check box (1) if you want to enable push services, whereby on-the-fly 
messages such as latest traffic reports, stock quote updates, etc. are automatically delivered 
to your device. If you do not want to use push services, go directly to step 6. 

- Complete the Address box (2) with the IP Address for the push gateway. This is a sequence 
of digits comprised of four integers separated by decimal points, for example: 193.96.141.24. 
This information can be found in the notice included in the push operator's welcome pack.  

- Complete the Port box with the port number used by the push gateway i.e., 2948 
(connectionless push gateway), 2949 (connectionless push gateway with WTLS), 9120 
(WTLS) or 9209 (no connectionless push gateway + no WTLS). 

- Select the Connectionless push gateway check box (4) if the push gateway works in 
connectionless mode. 

- Select the WTLS secured connection check box (5) if the push gateway uses the WTLS 
technology for enhanced security over the wireless network. 

Note:  
Incoming push messages are immediately signaled by a popup in your micro-browser. You 
have the choice to accept it (i.e., read it or go the suggested site) or keep it for later. In the 
second case, a special icon will be displayed on the Home page, near the Location globe 
icon. 

6. Select the History/Cache tab to edit the history settings. 
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- Use the first spin box (1) to specify the number of navigation steps that must be available for 
the Forward and Backward options of your EzWAP microbrowser.  
If you want to reset the history content and start with an empty one, tap the Clear history 
button (2). 

- Use the second spin box (3) to adjust the cache size (in kilobytes). (In the example above, 
EzWAP uses 100Kb to avoid systematically reloading data from the network).  
If you want to reset the cache content and start with an empty one, tap the Clear cache 
button (4). 

- Complete the Document cache path box (5) with the full path of the cache on your mobile 
device. 

- Complete the Cookies cache path box (6) with the full path for cookies on your mobile 
device. 

7. Select the Identification tab to specify the identification/localisation options. 

 

- Select the first check box (1) if you have a mobile subscriber ISDN (MSISDN) contract and 
you accept that your phone number be supplied to visited sites for customisation purposes. 
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Use the input text box (2) to enter your phone number, including: country code, national 
destination code and subscriber number.  
For example: 32 0477 387 20 00 (32 for Belgium, 0477 for local operator, 3872000 for 
mobile). 

- Select the second check box (3) if you accept that your geographical location details be 
supplied to visited sites for customised service offers. This may be useful for example if you 
often visit sites like weather forecasting sites that broadcast custom forecasts depending on 
where you are in the world. 

8. Tap OK (7) to save the new settings. 

9. If you have selected the check box to accept that your geographical location details be supplied to 
visited sites in step 7, tap the globe icon on the EzWAP home page then tap the Add button to 
supply the details of your current geographical location or specify new potential locations. 

 

- Complete the Location name box (1) with a name of your choice to identify the location.  
For example : French offices. 

- Complete the Geo.gsm  box (2) with the full location details of your GSM.  
The format must be: MCC;MNC;LAC;CI. For example: 234;33;52;49929. This 
information is available in the system parameters of certain gsm models. For more details, 
please enquire with your mobile operator.  
 
MCC - Mobile Country Code. For example: 206 for Belgium, 460 for China, 208 for 
France, 262 for Germany, 222 for Italy, 214 for Spain, 234 for UK, 250 for Russia, 
310 for USA, etc. 
MNC - Mobile Network Code. For example: 01 for Proximus (Belgium), 00 for 
Chntelgsm (China), 01 for Itineris (France), 01 for Deutsch Telekom (Germany), 
10 for Omnitel (Italy), 07 for Telefonica (Spain), 10 for Cellnet (UK), 150 for 
BellSouth (USA), etc.     
LAC - Local Area Code. A value between 0 and 65535. 
CI - Cell ID. Number identifying the active cell. For example: 49929. 

- Complete the Geo.position box (3) with the coordinates of your geographical position.  
The format must be: latitude;longitude;elevation (optional).  
For example, 48.54;-123.84;120 indicates a location 120 meters above datum (elevation) at 
position 48.51 degrees North (latitude), 123.84 degrees West (longitude). 
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- Complete the Geo.region box (4) with the standard ISO 3166-1 and ISO 3166-2 codes of 
your country and region.  
For example, ES-M for Madrid, GB-LND for London, FR-75 for Paris, CN-71 for Taiwan, CA-
ON for Ontario.  

- Complete the Geo.location box (5) with the exact name of the place. 
For example: Hôtel Georges V, Paris. 

10.  Tap OK to save the location details. 
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Surfing with EzWAP  

To surf with EzWAP 

1. In the location box (1), enter the URL of the site that you want to access. 
Or, 
To access a local file, replace http: by file:   
For example: 
- file:c:\program files\ezos\ezwap\ezos.wmlc 
- http://wap.ezos.com 
Or, 
Tap the location selection box to select a recently visited site. 

Note:  
If you tap (3), the address in the upper box (1) will be replaced by the corresponding title 
information. 

2. Press Enter. 
Or, 
Tap the go button (2) to launch the request. 

 

3. When the document is loaded, select the appropriate hyperlinks (4) to browse through the 
available pages. 

 

To define bookmarks 

1. In the location box, enter the URL of the site for which you want to define a bookmark. 

2. In the Tools menu, select Bookmarks. 

3. In the Bookmarks menu, select Add… to open the bookmark definition dialog box. 
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4. Type a name for the site in the Bookmark name box (1). 

5. Tap OK (2) to save the new bookmark. 

(To access the site afterwards, choose the Tools > Bookmarks > View… menu sequence, then 
select the site in the bookmark list and tap OK.) 
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Navigating Through EzWAP  

Navigation Buttons 

 

BUTTON NAME MEANING 

 Stop abort loading 

 Reload reload the current document from network rather than from 
cache 

 Home load the home page specified in the general options 

 Back go backward into the history 

 Forward go forward into the history 

 Card display the card contextual popup menu. This menu may be 
empty or contain site specific actions 

Note:  
The Home, Backward, Forward, Stop and Reload buttons are also available from the 
View >Go menu (see below). 

 

View Menu Options 

The View menu contains options to view the source of a page and to refresh the view. 
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MENU OPTION MEANING 

Go Display the currently selected page, load the home page specified 
in the Preferences (Home), the previously accessed page 
(Backward), the next page in the browse history (Forward), stop 
loading (Stop) or reload the current document from network rather 
than from cache (Reload) 

History… Display the recent browse history 

Source… Display the WML, CHTML or XHTML source code of the current 
page 

Address bar Show or hide the address bar 

About… Display information about the current version of EzWAP 

Exit Close EzWAP 
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Generating a SecurID 

Access to a number of secure mobile e-business sites is subordinated to a control of authentication by 
means of a unique RSA SecurID. EzWAP allows you to generate one-time SecurIDs based on 
existing activation licences. 

To generate a SecurID 

1. Tap the Tools menu and select SecurID… 

2. In the Information dialog box, enter your current passphrase if you have already defined one, or 
enter a passphrase of your choice if you have not defined it yet. 

3. Tap OK. 

4. In the SecurID fob, select the activation licence (1) for which you need to generate the SecurID (if 
the licence is not in the list, tap New from the selection box to add the details of a new licence 
manually or to import it from a file), use the number keys (2) to enter the input code provided by 
the site, then tap Generate  (3).  

 

 

5. Copy the generated SecurID (4) to the target location on the secure site.   

Note:  
SecurIDs are valid only for a very limited period of time (usually 1 minute) and suppose that the 
time on the mobile device is exactly the same as on the remote server. The lowering pile before 
the SecurID gives an indication of the remaining time to validate the SecurID on the site. If there is 
a certain time lag between the system time on your mobile device and the server time, meaning 
that the SecurID may have already expired by the time you type it in the site, tap Next to generate 
a further SecurID, and try with this one instead.  
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Glossary 

Authentication  

The verification (check) of the identity of a user. Authentication can be carried out user-oriented 
(user authentication) or computer-oriented (by the computer address). 

Cache 

A small fast memory holding recently accessed information, designed to speed up subsequent 
access to the same data.  

Card 

An organisation metaphor used to refer to a block of WML code. A card usually defines a single 
action or operation that will be available on a small screen. Depending on the application, a 
number of action cards can be bundled into a deck to offer a more complex resource. 

CHTML 

Compact HTML. An alternative language to WML, that was developed by the Japanese 
company NTT DoCoMo for web browsing and exchanging email from mobile devices. 

Cookie 

A piece of information, such as login or registration information, online “shopping cart” 
information, user preferences, etc., which is sent by a (WAP) server to a browser. This 
information may be saved locally on the device for quicker, customised access to visited pages. 

Deck 

A sequence of WML cards available organised as a single unit for transmission to a WAP 
device.  A deck is similar to an HTML page when thinking in terms of Web pages, in that it is 
identified by a Web address and is the basic unit of content transmission. 

i-Mode 

A text-based mobile information service developed by the Japanese company NTT DoCoMo in 
February 1999. i-Mode uses CHTML (compact HTML) for web browsing and exchanging email 
from mobile devices, very much like WAP uses WML to browse decks and cards.   

IP address  

The unique number that identifies a machine on the Internet. Usually, this address is 
represented by four numbers joined by periods, like 129.133.10.10. The first two or three pieces 
represent the network that the system is on, called its subnet. For example, all the computers 
for Wesleyan University in the U.S.A. are in the subnet 129.133, while the number in the 
previous paragraph represents a full address to one of the university's computers. 
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M-Services 

A text-based mobile information service developed a major American standards organization in 
December 2000. M-Services uses XHTML Basic, a stripped-down version of XML, for web 
browsing and exchanging email from mobile devices, very much like WAP uses WML to browse 
decks and cards. 

MSISDN  

Mobile Subscriber Integrated Services Digital Network. A standard description of a mobile 
phone number (i.e., phone number without the International Direct Dial (IDD) access code for 
the country).  

Proxy  

A server configured to act as a security barrier between an internal network and the Internet, 
keeping other people on the Internet from gaining access to confidential information on the 
internal network or on individual PCs connected to the network. 

Push  

A new technology responsible for the proactive delivery of information from a gateway to a WAP 
device.  

Skin 

A custom appearance that determines the general layout of a micro-browser. 

WAP Gateway 

A dedicated two-way device that translates WAP contents and user requests using a common 
WAP protocol. Similar to a "door" through which data would transit between the Internet and the 
wireless network.  

WML (Wireless Markup Language) 

The markup language used to create decks. WML fulfils the same purpose as HTML does on 
World Wide Web. 

WTLS (Wireless Transport Layer Security) 

The protocol used to ensure security (data integrity, confidentiality, authentication and non-
repudiation) between the wireless device and the WAP gateway/proxy.  

XHTML 

An alternative language to WML, that was developed by a major American standards 
organization for web browsing and exchanging email from mobile devices. 
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Cool WAP Site Collection 

The following collection contains a selection of interesting WAP sites to begin your exploration. 
 
URL http://wap.wapbone.com/ 
Language English 
Description The world's largest directory to WAP services, including site 

descriptions and user ratings 
 
URL http://wap.ananova.com/ 
Language English 
Description News, weather and entertainment 

 
URL http://wap.ayg.com/ 
Language English 
Description The latest news about recent developments in the wireless 

technology, WAP, I-Mode, J2ME, Bluetooth, etc. 
 
URL http://wap.wapgoal.com/ 
Language German 
Description All about football. News and reports about the UEFA Cup and the 

Champions' League 
 
URL http://wap.paf1.com/ 
Language English 
Description A facts site with useful tools including a conversion utility, 

geography facts and a dictionary/thesaurus 
 
URL http://wap.2pl.com/ 
Language Language selection 
Description Travel guide (hotel, tourism companies, tourist offices, etc.) 

 
URL http://www.palmreach.com/index.wml 
Language English 
Description Chat room (registration needed) 

 
URL http://wap.ludiwap.fr/ 
Language French 
Description Interactive online games and entertainment 

 
URL http://wap.djuice.com/ 
Language English 
Description Portal site (Good site !) 
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URL http://wapaw.com/index.phtml?format=wml 
Language English 
Description Search engine (Good site!!!) 

 
URL http://www.waptastic.com/application/wml.asp 
Language English 
Description Very complete portal site (FAQ, Articles, WML guide, etc.) 

 
URL http://wap.the451.com 
Language English 
Description News site 

 
URL http://wapmap.com/ 
Language English 
Description Search engine (Very good site!) 

 
URL http://mobile.worldof.net 
Language English 
Description Flight information 

 
URL http://showmewap.com 
Language English/French 
Description Search engine 
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Bug Report 

Please fill the following form and send it to software@ezos.com. 
 
Thank you for your help! 
 
The EzWAP Development Team. 
 
      

EzWAP version / build : ……………………….. 
 
OS/Platform : ………………………….……….. 
 
Problem area :  [ ] Com 
  [ ] Navigation 
  [ ] User Interface 
  [ ] Other…  Please specify : ………………………..……………………………… 
 
Problem type : [ ] Crash 
  [ ] Unable to access a WAP site 
  [ ] Bad data display 
  [ ] Other…  Please specify : ………………………..……………………………… 
 
Is the problem reproducible? [ ] Yes 
    [ ] No 
    [ ] Don’t know 
 
Please provide a detailed description of the specific problem you experienced. 
Tell us what you expected to happen and what actually happened. 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 

 
Other remarks or suggestions: 

………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 
………………………..………………………………………………..………………………….……… 

………………………..………………………………………………..………………………….……… 
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